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This document was prepared by collecting and condensing materials and resources for large assemblies in Solid Edge. 

Credit is given for Siemens documentation, and to Summit Tool and netPLM. 
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Introduction  

Solid Edge contains a number of technologies and tools that accommodate efficient interaction with large 

assemblies. The term "large" assembly is a relative one. What I might consider a large assembly may be 

common place to you. If you work with your large assembly on a daily basis you probably do not think of it as 

large. A large assembly can be thought of in terms of the number of parts in the assembly, but ultimately it is 

the amount of data that you are attempting to manipulate in memory that makes an assembly feel large. That 

said, there does happen to be a strong correlation between the number of parts in the assembly and the amount 

of data in memory. A 100 part assembly is not the definition of a large assembly, but if each of the parts is 

about one megabyte in size and you have 128 megabytes of memory on your computer then working with this 

assembly will be less than optimal.  

When we first saw a 1,000-part assembly from one of you, our Solid Edge customers, we thought, "Hey, now 

THAT’S a large assembly." Soon after, one of you had a 2,000-part assembly. Now, 3,000 and 4,000 have been 

surpassed, and there is even a 14,000-part assembly on record. None of these milestones happened over night 

and along the way Solid Edge has improved to better accommodate your large assembly requirements – 

eliminating inefficiencies, introducing new technologies, and adding tools that help you work more efficiently 

with large assemblies.  

The key to working with large assemblies ultimately lies in reducing the burden on the resources of your 

computer. The most important of those resources is physical memory. Once the size of your data set exceeds the 

amount of physical memory on your computer you begin using virtual memory. Virtual memory is not memory 

at all – it is allocated space on the computer’s hard disc. When physical memory is exceeded the operating 

system on your computer is responsible for moving data between physical memory and virtual memory as 

necessary to carry out operations – this is commonly known as "swapping". Once swapping occurs interactive 

performance is less than optimal.  

The intent of this document is to provide information on the technologies and tools within Solid Edge that help 

you work more efficiently with large assemblies. You can best benefit from their utility if you understand their 

existence and application. There are several categories of discussion.  
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CAD Workstation 

Regarding your computer there are several considerations of which two are primary when working with Solid 

Edge. One is memory, as you can probably guess from the introduction, and the other is your graphics board.  

Memory  

You need memory, and lots of it. How much memory you need is a matter of your potential data set size. Note 

the use of the term "potential" meaning not your current data set size. Customers like you who regularly work 

with 2,000 and 3,000 part assemblies have 512 megabytes to 1 gigabyte of memory. If your data set size has 

already exceeded your physical memory then you probably know how much memory you need to add.  

Graphics Board  

Solid Edge’s display efficiency is enhanced if your computer has a graphics board that supports OpenGL 

acceleration. Solid Edge’s shaded display data is manipulated directly by OpenGL during dynamic view 

operations. The more advanced the graphics board and the more memory on board the better, but having any 

OpenGL acceleration is better than having none. Many brands are commercially available and like other 

hardware components prices have become economically attractive.  

Network  

Accessing files over a network is inherently slower than accessing files from your own hard disc. This fact is 

true not only of Solid Edge files but also any file. Opening a Microsoft Word file over the network is slower 

than opening the same Word file on your hard disc. Accessing files over a network is initially limited by the 

speed at which the network operates, and further limited by the traffic on the network – the traffic being what 

other computers on your network are using the network for. The bottom line, as usual, is that faster is better.  

Ethernet and Fast Ethernet operate at 10 and 100 megabits per second respectively. Gigabit Ethernet operates at 

1000 Mbps but requires fiber optic cable. Even if you have a 100 Mbps network you will not fully realize its 

benefit if your computer only supports 10Mbps, as is the case with many older computers ("older" once again 

being a relative term.) These issues are best left to the network professionals at your company where they can 

be addressed in context of the business as a whole. Your desktop is likely not alone in demanding higher 

performance networking.  

Multi-processors  

The hidden line display mode of Solid Edge takes advantage of multiple processors if present; resulting in 

improved performance when hidden line is processed.  
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Operating System Requirements and Information 

This release of Solid Edge with Synchronous Technology has been certified to run on the following: 

 Windows XP Professional® operating system (32-bit or 64-bit)  

 Windows Vista Business© or Vista Enterprise© operating system (32-bit or 64-bit)  

 Internet Explorer 7.0 (IE 6.0 minimum)  

Solid Edge requires these versions (or later) to install due to system files delivered with these versions that Solid 

Edge relies on for proper operation.  

The 64-bit version of Solid Edge requires Microsoft 64-bit Windows XP operating system or 64-bit Vista operating system 

loaded on Intel EM64T or AMD64 processors.  (More details are below under System Resource Requirements and 

Information.) 

Solid Edge stops certifying new releases against an operating system shortly after Microsoft drops mainstream 

support for it. Windows ME, Windows 98, Windows NT 4.0, and Windows 2000 are unsupported operating 

systems. Solid Edge will not install on these operating systems. It is not recommended that you run Solid Edge 

on Server operating systems.  

Solid Edge will not install on machines without Internet Explorer 6.0 or higher. Internet Explorer is not required 

to be the default browser.  

Solid Edge is not supported on Intel Itanium processors.  

Solid Edge has been certified to run on 64-bit Windows XP or 64-bit Windows Vista as a 32-bit application. 

Below are the known issues running on these operating systems: 

 The "Status" and "Project" tabs are not displayed on the File Properties dialog if activated from 

Windows Explorer.  

 Solid Edge Web Parts do not display if running the 64-bit version of Internet Explorer. The user is 

prompted to Install the .NET framework. The workaround is to use the 32-bit Internet Explorer.  

Hardware System Requirements 

Recommended System Configuration: 

 32-bit (x86) or 64-bit (x64) processor 

 Windows XP Professional Service Pack 2 or 3 

 At least 2 GB RAM   

 True Color (32-bit) or 16 million colors (24-bit)  

 Screen resolution set to 1280 x 1024  

http://www.dell.com/64bit
http://www.dell.com/64bit
http://www.dell.com/64bit


 

 

 

 Large Assembly Bulletin – Page 6 of 30   netPLM 

  1060 N Capitol Ave 

Suite E-250 

  Indianapolis, IN  46204 
888-571-9038 

 

 

Minimum System Configuration: 

 32-bit (x86) or 64-bit (x64) processor 

 Windows XP Professional  

 At least 1 GB RAM   

 65K colors  

 Minimum Resolution: 1024x768  

 Disk space required for installation: 1.7 GB 

  

Vista Recommended System Configuration: 

 32-bit (x86) or 64-bit (x64) processor 

 Windows Vista Business or Enterprise Service Pack 1 

 At least 2 GB RAM 

 True Color (32-bit) or 16 million colors (24-bit)  

 Screen resolution set to 1280 x 1024  

 Windows Vista Aero© requires a DirectX 9-class graphics processor that supports the following: 

WDDM driver 

Pixel Shader 2.0 

32 bits per pixel 

256 MB graphics memory 

Vista Minimum System Configuration: 

 32-bit (x86) or 64-bit (x64) processor 

 Windows Vista Business or Enterprise 

 At least 1 GB RAM 

 65K colors  

 Minimum Resolution: 1024x768  

 Disk space required for installation: 1.7 GB 

  

Vista Recommendations 

On Vista, it is strongly recommended that you turn off User Account Control (UAC).  If UAC is on, you may 

experience slow network connects, problems with Solid Edge installation and product removal,  problems with 

Solid Edge licensing, problems with Insight web parts and perhaps other problems.  To turn off UAC, go to 
Control Panel - User Accounts and Family Safety - User Accounts - Turn User Account Control On or Off. 
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It is strongly recommended that you turn off Windows Vista Aero© if you will be working with View and Markup or the 

Solid Edge Viewer. To turn off Windows Vista Aero© follow these steps: 

Go to Control Panel. 

 If Control Panel Home is selected at the far left of the screen then:  

Click Appearance and Personalization, click Personalization, and then click Window Color and 

Appearance. 

 If "Classic View" is selected at the far left of the screen then: 

     Click Personalization, and then click Window Color and Appearance. 

 If you see Window Color and Appearance at the top of the window, then you should have "Open classic 

appearance properties for more color options" at the bottom of the window.  Click it.  In the Appearance 

Settings window, change the color scheme from Windows Aero and click OK. 

 If you don't see Window Color and Appearance, but see Appearance Settings, then check to make sure the 

Color scheme is not set to Windows Aero and click OK. 

Note:  If you see the Appearance Settings dialog box instead of the Window Color and Appearance window, 

then the theme might not be set to Windows Vista, the color scheme might not be set to Windows Aero, or the 

computer might not meet the minimum hardware requirements for running Windows Aero.  

Display System Requirements and Information 

Solid Edge will run on graphics drivers that support Windows XP or Windows Vista. Contact your graphics 

driver manufacturer to determine whether their graphics adapter/driver support these operating systems. 

For optimal performance, it is recommended to use a professional graphics card that is designed for CAD 

applications. For information about cards used in testing Solid Edge and results, refer to 

http://support.ugs.com/online_library/certification/. 

At least a 256MB graphic card is recommended when working with large assemblies or complex parts. 

Note that running with extremely high screen resolution and color depth increases the memory requirements on 

the system and may result in apparent performance degradation. If experienced, reconfigure the display system 

to the recommended resolution and color depth for improved performance. 

When running Solid Edge, if you experience an abnormally high abort rate, parts disappearing, or other graphic 

anomalies you may not be using the appropriate graphics driver. For more details, visit 

http://support.ugs.com/online_library/certification/. 

http://support.ugs.com/online_library/certification/
http://support.ugs.com/online_library/certification/
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Also setting Display Fonts to Large Fonts or Extra Large Fonts (larger than 96 DPI) may cause some Solid 

Edge user interface items to not display as intended.  Recommendation to resolve these would be to use Normal 

Fonts (96 DPI).  

System Resource Requirements and Information 

Earlier versions of Solid Edge were enhanced to access the extended address space that is available on 

Windows. Each running process has 4 GB of addressable memory available, regardless of the amount of 

physical RAM. Normally, the operating system reserves 2 GB of space and leaves 2 GB for applications. 

Running Windows XP or Vista (32-bit) with the /3GB switch added, reserves only 1 GB for the operating 

system, and leaves 3 GB for applications. This allows you to work with larger datasets without running out of addressable 

space. 

On XP, you set the /3GB switch by editing the boot.ini file.  Here is a sample boot.ini that contains a 3 GB switch. 

[boot loader] 

timeout=30 

default=multi(0)disk(0)rdisk(0)partition(1)\WINDOWS 

[operating systems]  multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows 

XP Professional"  

/fastdetect /NoExecute=OptIn multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft 

Windows XP Professional /3GB"  

/fastdetect /NoExecute=OptIn /3GB  

Note: There were some XP SP1 problems on some machines trying to boot using these /3GB switch. Microsoft 

resolved these issues in XP SP2.  

On Vista, you can run the following command from the command line to enable /3GB switch: 
        BCDEDIT /Set IncreaseUserVa 3072  

 

This command will tell you what options are part of the OSLOADER family 
        bcdedit /? types osloader 

 

To reset the value, use 
        bcdedit /deletevalue IncreaseUserVa 

 

You must have admin privileges to do so. 

With Solid Edge V18, we announced support for running our existing 32-bit Solid Edge 

application on Microsoft Windows XP Professional x64 Edition with Intel EM64T or AMD64 processors. This 

allowed Solid Edge customers to address 4 GB of physical memory and virtual memory. With Solid Edge V19, 

we developed a new 64-bit Solid Edge application, in addition to the existing 32-bit version. The 64-bit Solid 

Edge supports up to 128 GB of physical RAM and 16 terabytes of virtual memory, enabling applications to 

work with larger data sets. The 64-bit version of Solid Edge requires Microsoft 64-bit Windows XP operating system 

or 64-bit Vista operating system loaded on Intel EM64T or AMD64 processors. The 64-bit version of Solid Edge 

should only be used if you need more than 4 GB of physical memory because you are running out of memory  

http://www.dell.com/64bit
http://www.dell.com/64bit
http://www.dell.com/64bit
http://www.dell.com/64bit
http://www.dell.com/64bit
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today when creating very large assemblies or drawings. The 64-bit version of Solid Edge is available by 

request. 

Page file size should be the maximum size possible. In general, the page file size should be at least twice the 

amount of memory in the machine, plus the size of files you will use.  

To better manage the system memory resources while running Solid Edge, it is important to turn off the option 

to "Show window contents while dragging". This prevents unnecessary allocation/deallocation of memory for 

displaying the window contents while dragging a window. To change this option, go to Control Panel -> 

Display.  

Future Processor Support 

Component software delivered with Solid Edge, such as Parasolid and D-Cubed, started phasing out processors 

not supporting Intel's SSE2 (Streaming SIMD Extensions 2) instruction set.  In 2009, these components will 

only support processors with SSE2.  Starting with the 2009 release of Solid Edge, it will only support 

processors that include the SSE2 instruction set.  

Temp File Space 

Solid Edge uses temp file space for saving files and for storing memory mapped display files. Using temp file 

space when saving files helps significantly reduce the size of the resulting file on the destination file system.  

Users should ensure they have twice the size of the largest file being saved available as free temp file space 

prior to saving their files. Note, 2x the file size for an assembly should include the size of the assembly, plus the 

size of the subassemblies that are being used, plus the size of the part files.  

Running SE will create files with .000, .001, etc. extensions. These are memory mapped files that are used in 

the display pathway. When an assembly or part file is opened, memory mapped files are created in the temp 

directory during display of the assembly/part. These files are cleaned up by Solid Edge when the process exits. 

If the user is running short on temp space, they can optionally set an environment variable called 

JRENDER_TEMP and point it to any folder with sufficient space. If this variable is defined, Solid Edge will 

create memory mapped files in that folder.  

Running SE will create a file named DCCACHE.CAC in the system temp folder. This file is a cache of the file 

icons displayed on the FILE OPEN/FILE SAVE/BROWSE dialogs.  

When a Solid Edge file is opened, but Solid Edge cannot gain exclusive write access to that file, a message box 

is displayed stating, "The requested file is currently write locked, open as read-only". If the user selects the copy 

button on this message dialog, the file will be copied to the temp folder using the naming convention tmp.par, 

tmp.psm, tmp.asm, tmp.dft.  

 



 

 

 

 Large Assembly Bulletin – Page 10 of 30   netPLM 

  1060 N Capitol Ave 

Suite E-250 

  Indianapolis, IN  46204 
888-571-9038 

 

It is good practice to periodically check the files in the temp folder when not running Solid Edge and delete any 

that might remain from an abnormal termination of Solid Edge.  

Solid Edge Templates 

If you intend to use the template files supplied with Solid Edge with Synchronous Technology, it is a good idea 

to open them and customize them further for your company's specific needs. Modifying the templates supplied 

with Solid Edge is the best way to keep up to date with template files and new capabilities and settings in Solid 

Edge.  

If you intend to use your existing template files with Solid Edge ST, please follow these recommendations:  

1. Open your existing template files in Solid Edge ST and save and close them. The act of opening and 

saving brings all information stored in the template up to date and will save time when creating new 

draft files from these template files.  

2. After saving the template files, open them a second time and inspect all data in the templates for 

accuracy.  

Other template recommendations 

 You should avoid the use of drawing views of parts or assemblies on background sheets.  

 It is good practice to put property text callouts on the background sheet for sheet file name, author, 

linked file name, etc. The use of property text in background sheets of template files can save 

considerable work in many workflows.  

 If you traditionally put symbols on the background sheets of draft files, we recommend you use Blocks 

instead. Your old symbol files can be dragged and dropped into a template background sheet directly 

and will form blocks if the “Show blocks" button is active on the Library tab of the EdgeBar, or if the 

insert mode is Block.  

 If you want to use symbols rather than blocks on the background sheets of draft files, we recommend 

you not use the "linked" option. We recommend the use of "insert as geometry" for symbols in template 

files. Linked or embedded files may offer advantages in some situations, but our findings have been that 

workflow and process problems associated with keeping up with linked files, modifying files linked to 

released drawings, and similar issues make the use of linked files to background sheets less than 

desirable.  

Warning: If your draft file templates have linked or embedded AutoCAD files on the background sheet using 

the Viewdata tool supplied with early versions of Solid Edge, you are working in an inefficient and non-

recommended manner. Direct embedding of AutoCAD files using Viewdata was disabled in V9, although 

display of existing files with these embeddings is still provided.  
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If you have templates with embedded or linked AutoCAD files follow these steps: 

1. Locate the original AutoCAD file used in the link or embed.  

2. Open your draft template file and view the background sheet.  

3. Delete the linked or embedded AutoCAD object on the background sheet.  

4. Open the AutoCAD file you want to use as on the background sheet in Solid Edge Draft, thus using the 

translator to bring the data into Solid Edge native format.  

5. Copy the translated data and paste it in your template file on the background sheet.  

6. Save your template in Solid Edge ST.  

Solid Edge Standard Parts  

The Standard Parts functionality in Solid Edge requires the "Microsoft Data Access Components (MDAC)" in 

support of the Standard Parts database. Standard Parts requires MDAC 2.7 or higher. MDAC can be 

downloaded from Microsoft from the following site: http://www.microsoft.com/downloads/. Expand the "Most 

Popular Downloads" list and follow the MDAC 2.8 link in the list.  

IMPORTANT NOTE: The above and higher versions of the Microsoft Data Access Components (MDAC) are 

not supported on SQL Server 7.0 or 6.5 clustered installations. Please do NOT install any of these releases of 

MDAC on such servers; doing so will break your cluster. 

Updating Standard Parts Database 

To use Solid Edge with Synchronous Technology Standard Parts, V20 and earlier standard parts databases are 

NOT compatible and must replaced.  

 Follow these steps to update your database: 

 Run Configuration Wizard to specify the location of the existing database.  

Note: Before running Configuration Wizard, you should rename the V20 database or change the default name 

of the Solid Edge ST database specified in the Configuration Wizard. 

 Install the Solid Edge ST Machinery Design parts by identifying the top level standard parts folder name 

during Configuration Wizard setup.  

 Run Solid Edge Administrator and use the Add Parts command on the 3D-Standard_Parts_V8.50 folder. 

By adding the parts through setup, the previous version standard parts will not be over-written by the 

Solid Edge ST standard parts.  

The Solid Edge ST Standard Parts will be written to a different folder. If you added custom parts to your V20 

standard parts database, you will need to add these parts again to your Solid Edge ST database. Depending on 

the age of the custom parts, you may be required to edit the part in Part Editor during the process.  
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Solid Edge ST Standard Parts has added the capability to migrate previously unmanaged standard parts to 

Teamcenter. For more information on this and other Standard Parts topics, review the Standard Parts 

Installation Guide available at http://support.ugs.com/docs/solid-edge.shtml. 

 

Assembly Essentials  

The bare essentials of assembly management, large or small, involve the use of the following commands: 

Activate, Inactivate, Show, and Hide. The use of these commands and the underlying technology they enable is 

imperative to reducing the amount of data that is loaded into memory when an assembly is open.  

It is useful to understand the defining characteristic of active and inactive parts. When a part is inactive, only 

the display data of the part is in memory – the part file and the solid body of the part are not in memory. 

Operations that require access to the solid body or faces of the solid body require that the part be active, but 

operations such as select and display only require that the part be inactive.  

Activate  

The Activate command loads a part file into memory and makes the part available for operations that require the 

part to be active. The part remains active until explicitly inactivated.  

 The use of the terminology "a part" is not meant to indicate that these commands only operate on a 

single part – the commands operate on a select set of parts. 

Inactivate  

The Inactivate command unloads a part file from memory, leaving only the display data of the part in memory.  

Auto-activate  

Auto-activate is not a command it is a behavior. Commands that require a part be active to operate on the part 

will automatically activate the part. For example, if you place an assembly relationship to a face of an inactive 

part, the relationship command will activate the part. With this behavior you do not need to explicitly activate a 

part prior to placing a relationship to the part.  

Show  

The Show command turns on the display of a part that is currently hidden.  

 

http://support.ugs.com/docs/solid-edge.shtml
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Hide  

The Hide command turns off the display of a part that is currently shown.  

Show Only  

The Show Only command hides parts that are not in the select set leaving the selected parts shown.  

 To isolate a sub set of parts in a large assembly try using Show Only in combination with a select tool 

discussed later in this document. 

Unload Hidden Parts  

The Unload Hidden Parts command unloads hidden, active parts from memory. If the part is shown again the 

display data will be retrieved from the part file.  

 

Opening an Assembly  

When an assembly is opened, by default, parts that were shown when the assembly was last saved are shown 

when the assembly is opened. Parts that were hidden when the assembly was last saved are not loaded into 

memory at all when the assembly is opened.  

Stored Display Data  

If display data is stored in a part then this data is retrieved for display in the assembly when the assembly is 

opened. If the display data is not stored it needs to be generated when the file is opened, which is slower than 

retrieving that which is already saved.  

 To store display data in the part file set the Store geometry in part for fast open on the General tab of the 

Options dialog. The display data will be stored when the part file is saved. 

Activation Override  

When Solid Edge is installed an option is set to open all parts inactive when an assembly is opened. You can 

open an assembly with active and inactive parts as last saved by turning off the Activation Override, but leaving 

this option on provides the most efficient means of opening an assembly.  

 The Activation Over 

 ride option is available on the Open dialog or on the General tab of the Options dialog 
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Open with a Configuration  

If you have saved a configuration in your assembly you can open the assembly using a configuration. In this 

way you can open a functional system directly rather than opening the assembly as last saved and then applying 

the configuration of the functional system.  

The Configuration select control is available on the Open dialog. 

 

Simplifying Assemblies 

When working with a large, complex assembly, it can be useful to work with a simplified version of the 

assembly. For example, a large assembly with many subassemblies can process slowly. 

 

The commands in the Simplify group on the Tools tab in the Assembly environment allow you to create an 

exterior shell of faces that represents the assembly envelope, and exclude selected parts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

A simplified assembly processes more quickly when used in a higher level assembly or a drawing. You can also 

control whether the as designed or simplified assembly representation is used in other documents and when 

opening an assembly. This allows you to work with larger data sets more efficiently. 

 

You can also save the simplified representation of the assembly to a new document name. This can make it 

easier to share or protect proprietary information when exchanging data with other companies that need access 

to your data. 
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Simplified assemblies and memory usage 

 

When you create a simplified representation of an assembly, the data storage requirements for the assembly 

document increase because the surface data for the simplified representation is stored in the assembly 

document. 

 

The size increase required to support the simplified representation is small when compared to the size 

requirements of all the documents that make up the assembly. 

When you place a simplified assembly document as a subassembly into another assembly, the memory 

requirements required to display the higher level assembly drop dramatically. This improves performance and 

also allows you to work with larger data sets more effectively. 

 

This performance improvement also applies when creating a drawing of a simplified assembly. Because less 

memory is required to support the simplified data set, the drawing views will process quicker. 

 

 

Simplifying an Assembly 

 

You access the commands for simplifying an assembly using the Simplify Assembly command on the tools tab 

in the Model group. The Simplify commands allow you to create and update the simplified representation and 

save the simplified representation as a separate document. After you have simplified the assembly, you can 

return to the Assembly environment using the Design Assembly command on the Tools tab in the Model group. 

 

When you create a simplified representation of an assembly, an entry is added to PathFinder to indicate that a 

simplified representation of the assembly exists. 

 

 

Creating the simplified representation 

 

The Create Simplified Assembly command allows you to process the assembly to show only the exterior 

envelope of faces and to exclude parts, such as small parts, which reduces the total number surfaces that make 

up the assembly. The simplified assembly representation is associative to the components in the assembly.  

 

 

Updating simplified assemblies 

 

When you make design changes to assembly components, you must use the Update Simplified Assembly 

command to update the simplified representation before the design changes are displayed in a higher level 

assembly or drawing that uses the simplified representation. 
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Saving the simplified representation as a document 

 

You can use the Save Model As command on the Application menu to save the simplified representation of the 

assembly as a new Solid Edge Part document (*.PAR) or as a Parasolid document. 

This can be useful when another company uses your assembly as a part in their assemblies. This reduces the 

data-management and transfer requirements to a single document, and it can also protect any proprietary 

information that a complete assembly might reveal. 

 

Using simplified assemblies 

 

You can specify whether the as designed version or the simplified representation of the assembly is used in 

many down-stream operations. In some cases, other Solid Edge functionality requires that the as designed 

version is used. For example, you cannot create a simplified assembly representation of an alternate assembly. 

 

If you have already created a simplified assembly representation, then try to convert the assembly to an alternate 

assembly, a message is displayed to warn you that the simplified representation will be deleted. 

 

 

Placing simplified assemblies in other assemblies 

 

When you place an assembly as a subassembly in another assembly, you can specify whether the assembly is 

placed using the as designed or simplified version. The Use Simplified Assemblies command on the Parts 

Library shortcut menu allows you to specify how the assembly is placed. When you place the simplified version 

of the assembly, only the faces that comprise the simplified representation of the assembly are available for 

positioning the assembly using assembly relationships. 

 

You can use the commands on the PathFinder shortcut menu to specify whether the as designed or simplified 

version of a subassembly is used. You can control each subassembly in an assembly individually. This allows 

you to display the as designed version of a subassembly when needed, and then switch to the simplified version 

of the subassembly later to improve performance. 

 

 

Inactivating Simplified Subassemblies 

 

When working with large, nested assemblies that contain simplified subassemblies, you should work with the 

simplified subassemblies inactive whenever possible. This can significantly reduce memory requirements. 

 

You can use the Inactivate and Activate commands on the PathFinder shortcut menu to inactivate and activate a 

simplified subassembly. When placing or editing relationships, you can use the Activate button on the 

Assemble command bar to activate a simplified subassembly. 
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Creating drawings of simplified assemblies 

 

When creating or modifying drawing views of an assembly, options on the Drawing View Wizard and Drawing 

View Properties dialog box allow you to control how simplified assembly representations are applied.  

 

 

Opening simplified assemblies 

 

When opening an assembly, options on the Open File dialog box allow you to control how simplified assembly 

representations are applied.  

 

 

Moving simplified assemblies 

 

Because the simplified representation is considered a construction body, collision detection is not available 

using the simplified representation. 

 

 

Checking interference on simplified assemblies 

 

Because the simplified representation is considered a construction body, interference detection is not available 

using the simplified representation. 

 

 

 

Simplifying Parts 
 
When working with an assembly, it can be useful to work with a simplified version of a complex part. For 

example, a part that contains numerous rounds, chamfers, and holes will process more slowly than a part from 

which these features have been removed.  

 

The commands in the Simplify Model 

environment allow you to reduce the 

complexity of a part so that it processes 

more quickly when used in an assembly. 

The ultimate goal of part simplification is 

to reduce the total number of surfaces 

that make up the part. 

 

You can also control whether the 

simplified version or the designed 

version of the part is displayed in the assembly. 
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Simplifying parts 

 

You access the commands for simplifying a part using the Simplify command on the Tools tab in the Part and 

Sheet Metal environments. When you set the Simplify command, commands that can be used for simplifying a 

part are activated, and commands that are not appropriate for simplifying a part are disabled. For example, the 

commands on the Delete list on the Home tab in the Modify group are available for deleting faces, regions, and 

so forth.  

 

After you have simplified a part, you can return to the Part or Sheet Metal 

environment with the Design command on the Tools tab. 

 

You can also simplify a part by adding extruded and revolved protrusions, and 

extruded and revolved cutouts. Feature construction commands are included in 

the Simplify Model environment because sometimes it can be easier to simplify a 

part by adding one new feature than deleting many features. For example, you can 

construct one protrusion that obstructs several features, which then eliminates 

dozens of surfaces in one operation. 

 

The features you create in the Simplify Model environment are added to the 

Simplify section of the PathFinder tab in the part document. You can also use the 

commands on the shortcut menu within PathFinder to manipulate the simplified 

features you construct. 

 

 

 

Direct editing and simplifying compared 

 

Many of the commands available when directly editing a part are also available when simplifying a part in the 

Simplify Model environment. Deciding whether to directly edit the model or simplify the model is determined 

by whether you want to have access to a simplified version of the part in an assembly or when creating a 

drawing. 

 

If you want to use a simplified version of the part in an assembly or a drawing, you must set the Simplify 

command. No simplified version of the model is created when you directly edit a model. 

 

 

Saving simplified parts to a separate file 

 

You can save the simplified representation of the part out to a separate file using the Save Model As command 

on the Application menu. The Save Model As dialog box allows you to specify a file name, folder location and 

file format. You can save the new document as a Solid Edge document or as a Parasolid body, and it is not 

associative to the original model. 
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Simplified parts in assemblies 

 

When placing a part in an assembly, you can place it using the simplified version of the part, or the designed 

version of the part. When you set the Use Simplified Parts command on the Parts Library shortcut menu, the 

simplified version of the part is displayed when placing the part in an assembly. Any faces that you deleted 

when simplifying the part will not be available for positioning the part in the assembly. To make these faces 

available for positioning, clear the Use Simplified Part command before placing the part. 

 

When working with simplified parts in an assembly, you can control whether the simplified version or as-

designed version of the part is displayed. If you place the same part in an assembly more than once, you can 

control the display for each instance of the part individually. When you select a part in the assembly, you can 

use the Use Designed Part and Use Simplified Part commands on the shortcut menu to control which version of 

a selected part is displayed.  

Note: 

The Use Simplified Part command is not available for parts that were selected for an assembly feature, whether 

the parts were modified by the assembly feature, or not modified.  

 

 

Simplified parts in PathFinder 

 

The symbols adjacent to each part in the PathFinder tab in an assembly change to 

indicate whether the simplified version or designed version of the part is currently 

displayed. 

 

 

 

 

 

 

 

 

Locating edges in simplified models 

 

In some cases there may be edges in a simplified part that are not locatable. This occurs when the simplified 

version of the part creates edges that do not have corresponding design edges. 

 

When this occurs you will not be able to locate an edge on a simplified part when placing a dimension or 

relationship, or when including an edge. 

Location of these edges is purposely prevented to ensure stability of the model in downstream operations. 
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Simplifying Best Practices 

When considering whether to simplify an assembly, there are several factors that can determine whether you 

receive the maximum benefit from assembly simplification. This Help topic discusses these factors. 

 

 

Simplify both parts and assemblies 

 

Using simplified parts in conjunction with a simplified assembly improves simplified assembly performance in 

the following ways: 

 Faster creation of the simplified assembly representation because there are fewer total surfaces to 

evaluate. 

 Reduced assembly document size, which reduces memory demand. 

When you simplify parts before simplifying the assembly, you are reducing the total number of surfaces which 

must be evaluated during assembly simplification. This allows the assembly simplification process to complete 

faster. 

 

The wide range of commands available for part simplification also allow you better control over which part 

surfaces are removed prior to assembly simplification. For example, there may be holes and cutouts on an 

exterior part that are not necessary in the simplified assembly. If these holes and cutouts expose interior faces, 

the interior faces will be included in the simplified assembly. 

 

By simplifying the exterior part to remove the holes and cutouts, the simplified assembly representation will 

contain fewer surfaces, which reduces file size and memory demands. 

 

 

Simplify assemblies that contain enclosures 

Some assemblies are better suited to assembly simplification than others. In general, assemblies that have many 

interior components are better candidates for assembly simplification. This is because assembly simplification 

processes the assembly to show only the exterior envelope of faces and by excluding small parts. 

For example, assembly (A) is an ideal candidate for assembly simplification because there are many complex 

components enclosed by the exterior housing. The exterior housing itself also contains many interior surfaces 

that would be excluded by assembly simplification. 
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Assembly (B) is a poor candidate for assembly simplification because there are few interior surfaces and no 

interior components to exclude. If assembly (B) is also used in a higher level assembly, where assembly (B) is 

enclosed, that higher level assembly may be a better candidate for simplification. 

 

 

 

 

 

 

 

 

 

 

 

 

Open assemblies with simplified subassemblies 

 

When you open an assembly that contains simplified subassemblies, you can specify whether the assembly is 

opened with the subassemblies simplified or as designed. When you open an assembly with the subassemblies 

simplified, file open times are improved. 

 

 

Simplify deeply nested assemblies 

 

The more subassemblies and parts an assembly has, the more likely the assembly is a good candidate for 

simplification. When you open a large assembly with many subassemblies that have been simplified, file open 

performance is improved. 

 

 

Inactivate simplified subassemblies 

 

When working with large, nested assemblies that contain simplified subassemblies, you should work with the 

simplified subassemblies inactive whenever possible. This can significantly reduce memory requirements. 
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Avoid simplifying top-level assemblies 

 

The simplified assembly representation is stored in the assembly document in which it was created, which 

increases the file size. An assembly that has been simplified will open slower than an identical assembly which 

has not been simplified. 

This means that the top-level assembly itself does not benefit from assembly simplification. 

Although performance is improved when creating drawing views of a top-level assembly that has been 

simplified, in most cases this performance improvement does not offset the performance impact when opening 

the top-level assembly. 

 

Zones 
 

It can be useful to define a set of components in an assembly based on the volume of space the parts occupy. 

The Zones functionality on the Select Tools page in Solid Edge allows you to define a rectangular volume of 

space based on one or more assembly components you select. You can then use that named zone to select, 

display, or hide all the assembly components that are contained within the boundary of the zone. For example, 

you can select a named zone on the Select Tools page, then click the Hide Components command on the 

shortcut menu to hide all the assembly components in the zone.  

 

 

 

 

 

 

Note: 

You can use a zone to show, hide, and select parts, assemblies, assembly sketches, weld beads, 

coordinate systems, and reference planes in an assembly. Defining and using zones is especially useful 

when working with large assembly data sets. 
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You define a zone using the Create Zone command on the Select Tools page. When you click the Create Zone 

button, a command bar is displayed, with the Origin and Size Step active, which allows you to define the initial 

volume of the zone by selecting one or more assembly components. The range box of the design body of each 

selected component is used to calculate the zone box volume. 

Note: 

Construction bodies and simplified bodies are ignored when calculating zone box volume. 

 

 

You can select the components in the PathFinder page or the graphics window. For example, you can select a 

subassembly (A) using PathFinder. When you click the Accept button, a zone boundary box is displayed in the 

graphics window (B). The command bar then advances to the Modify Size Step, which allows you to further 

refine the size of the zone. 

 

 

 

 

 

 

 

 

 

To change the size of the zone during the Modify Size Step, you can select a face on the zone box, and then 

select a keypoint on an adjacent part or a point in free space.  

To control which components are included in the zone, you can specify whether the zone definition is inside or 

overlapping using the options on the command bar.  

When you finish defining a zone, a zone boundary box is displayed in the graphics window (B), and a zone 

name is added to the Select Tools page. You can also edit the size of a zone later.  

The zone boundary box volume is not associative to the parts used to define the zone. If you move, edit, or 

delete the parts used to define the zone, the size of the zone boundary box remains the same.  
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Note: 

When you create the first zone in an assembly, the assembly structure must be updated. A message is 

displayed to warn you that updating the assembly structure may take several minutes, depending on the 

size of the assembly. 
 

  

Modifying zones later 

 

You can edit the size of a zone later using the Edit Definition command on the shortcut menu when you select a 

zone entry in the Select Tools page, or a zone box in the graphics window. If you click the Origin and Size Step 

on the command bar, you can select new parts to redefine the zone boundary. If you click the Modify Size Step, 

you can edit the size of the zone boundary as described earlier. 

 

 

Displaying zone boundary boxes 

 

The zone box can be displayed or hidden in the graphics window. You can use the shortcut menu commands 

when you select a zone entry in the Select Tools page, or in the graphics window to show and hide a zone 

boundary box display. You can also show and hide all the zone boundary boxes using the Zones command on 

the View menu.  

 

 

Using zones 

 

Shortcut menu commands in the Select Tools page allow you to show only, show, hide, and select the 

components in a zone. You can also show all the parts in a zone by double-clicking a zone box in the graphic 

window.  

 

A part can belong to one or more zones. As you add new components to an assembly, the components are 

automatically added to the zone(s) they fall within. 

 

 

Zones and display configurations 

 

The functionality of zones and display configurations differ in a number of ways.  Both display configurations 

and zones are useful tools to manage component display in assemblies. The following information compares 

and contrasts display configurations and zones. 
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Display configurations 

 A display configuration allows you to control the display status of assembly components regardless of 

the components physical location in the design space.  

If you add components to the assembly, they are not added to an existing display configuration. You 

must apply the configuration, display the components you want to add to the configuration, then resave 

the configuration. When working in large, nested assemblies, shared by multiple users, it can sometimes 

be difficult to keep track of efficiently. 

When working with a family of assemblies, you can create member-specific display configurations. 

Zones 

 A zone allows you to show, hide, and select assembly components based on a rectangular volume of 

space you define when you create the zone. As you add new components to the assembly, they are 

automatically added to any existing zones they fall within. 

You can edit the physical size of a zone later to include or exclude components. 

When working with a family of assemblies, the zones functionality is not available. 

 

Updating the assembly structure 

 

When working with zones, assembly components that are considered to be inside or outside a zone is accurate 

as long as the assembly structure is up to date. The assembly structure can become out of date when multiple 

people are working on different subassemblies, and you then open a higher level assembly with some of those 

changed subassemblies hidden. For example, on the Open File dialog box, there are options that allow you to 

open an assembly using a display configuration, a zone, or with all components hidden.  

You update the assembly structure using the Update Assembly Structure button on the Select Tools page. When 

you click the Update Assembly Structure button, the entire assembly structure is loaded into memory to ensure 

that the assembly structure is up to date. 

Note: 

Updating the assembly structure can take several minutes, depending on the size of the assembly. 
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Display  

When an assembly is open each part that you see on the computer screen has its display data present in memory 

and is processed by Solid Edge's display system.  

Display Data and Accuracy  

When Solid Edge generates display data there are two settings that affect the accuracy of the data – the Display 

Quality and Arc Quality settings on the View tab of the Options dialog. Solid Edge is delivered with the setting 

at a level where we feel there is a good performance to accuracy ratio. As delivered you will undoubtedly 

experience the "small holes appear faceted" issue – meaning, a hole in a model that is small relative to the 

overall size of the model will appear faceted if you zoom in closely on the hole. That's because it is faceted. As 

a matter of fact, the entire model is faceted – the facets are the display data. How closely the display data 

matches the actual geometry of the model, or how small the facets are and how many facets there are, is a 

function of the display quality setting.  

 If you increase the Arc Quality setting then more facets are generated so circular edges, holes, appear 

smoother. 

 If you increase the Display Quality setting then more facets are generated for the entire model. 

As with any accuracy setting more accurate means more data. More data requires more space in memory and on 

disc. More data requires more processing. More processing reduces performance. Our suggestion is that you 

leave the display quality settings at the lower end of the scale, as delivered, when working with large 

assemblies. You may want to adjust these settings if a higher quality image for presentation graphics is 

required, but then return to the lower end of the scale for working interactively.  

Display Modes  

The first need-to-know fact about Solid Edge display is that the smooth shaded display mode provides the best 

performance – period. Other display modes include hidden line and phong shaded but smooth shaded is more 

performant than any other display mode. Even without OpenGL acceleration smooth shaded is more 

performant, but with OpenGL acceleration there is no comparison.  

In our observations during beta testing at the Solid Edge facility in Huntsville we find that most of you use the 

shaded display mode for part and assembly modeling operations. We also observed that quite often you change 

to the hidden line display as an alternate visualization technique, and then change back to shaded display to 

continue working. Solid Edge is unique in its ability to switch between shaded and hidden line display modes 

without regenerating the display data – this is a very fast operation.  

When hidden line is processed it is to an accuracy that achieves visual fidelity for the current view scale. If you 

zoom in greatly the accuracy may not be sufficient so hidden line is re-processed for the new view scale. You 

can control when hidden line is re-processed with the Refresh Scale setting on the View tab of the Options  
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dialog. The setting controls at what change in view scale that hidden line will be re-processed – a scale of 3 

means that hidden line will be re-processed if the view scale changes by a factor of 3x. This value can be set 

liberally as high as 99. Setting it to a value of 10 accommodates a fairly wide range of view scales, even when 

fitting and zooming frequently, while not re-processing hidden line. If you zoom in and are not satisfied with 

the hidden line quality you can simply use the Refresh command on the View menu to re-process hidden line.  

Keep it Simple  

Solid Edge contains an array of display related settings and options for view styles and face styles. Knowing 

that everyone likes a pretty picture there is a tendency to take advantage display options that add visual appeal 

to the displayed image, but to maximize performance you should avoid interactive use of compute intensive 

display options. Performance culprits include anti aliasing, depth fading, shadows, and phong shading, among 

others. Take advantage of these options for presentation graphics but do not use them interactively.  

A cutaway view is a useful tool for viewing internal components of an assembly by partially cutting external 

components that cover up the internal components. A cutaway view physically modifies the display data of the 

parts that are cut. If parts in the assembly are re-positioned, or parts are added or deleted, the cutaway view 

updates and modifies the cut parts as appropriate. In a large assembly the update of a cutaway view can become 

time consuming depending on how many parts the cutaway modifies. Take advantage of a cutaway view for 

presentation graphics but you may not want to use it interactively.  

The Move Part command will display movement of parts using the current display mode unless otherwise 

specified. If the current display mode is shaded then movement of the parts appears shaded. If you have 

OpenGL acceleration you probably experience reasonable performance during dynamics. If not, you should set 

the Wireframe display in Move Part command option on the View tab of the Options dialog.  

Locate Display  

When a part is located it is drawn in the highlight color to provide visual feedback as to what part is located. 

When a part is selected it is likewise drawn in the select color. The amount of time required to draw the 

highlight or select color depends on the number of edges in the part. Using box display for locate the amount of 

time required to draw the highlight or select color becomes a constant since only the edges of the part's range 

box are drawn.  

 The Fast locate using box display option is available on the View tab of the Options dialog. 
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Visual Clutter  

 For this topic of discussion the use of the term "clutter" is not meant in a negative sense. 

As a general rule you need only show the parts that are required to visually and functionally support the 

operations at hand. Parts that do not fit this description should be managed accordingly.  

 

Shaded display mode introduces an issue of parts visually covering up other parts. To work effectively in a 

shaded view you need to hide the parts that visually cover up the parts of interest for the operations at hand. 

This simple fact should not be looked on negatively since you achieve a view that is necessary for working on 

your assembly and because fewer parts shown means less data is processed by the display system, resulting in 

better performance. Most operations do not require that every part in the assembly be shown.  

Display Configurations  

Display configurations allow you to save multiple display states of an assembly with a descriptive name. A 

configuration stores the shown or hidden state of each part in the assembly when the configuration is saved. The 

configuration can subsequently be applied to restore the saved state. Configurations are useful for saving 

collections of parts that make up functional systems of your assembly.  

Configurations also store the active or inactive state of each part in the assembly. This state too can be restored 

when a configuration is applied.  

Culling During View Dynamics  

Small detail culling is a technology that improves performance during view dynamics – most notably view 

rotation. During view rotation if Solid Edge detects that the view cannot be redisplayed in an acceptable amount 

of time then small detail will not be redrawn dynamically. The less data redrawn the faster the redraw occurs. 

Culling is automatic and temporary during view dynamics, and when dynamics terminates the small detail will 

be again be redrawn. Culling is intended to be visually unnoticeable but small parts will disappear completely 

during dynamics.  

 The Display Culling option is available on the View tab of the Options dialog. The slider controls the 

size of what is considered "small" detail. Move the slider to the right to improve performance by 

increasing the size of part that will not be drawn during dynamics. 

Working in a Sub-assembly  

It almost goes without saying that you can work most efficiently if you work in the lowest level sub-assembly 

possible. If you find yourself opening an assembly and then in-place activating a sub-assembly and spending an 

extended amount of time working in the sub-assembly you should consider opening the sub-assembly directly  



 

 

 

 Large Assembly Bulletin – Page 29 of 30   netPLM 

  1060 N Capitol Ave 

Suite E-250 

  Indianapolis, IN  46204 
888-571-9038 

 

rather than editing through the higher level assembly. Of course this statement assumes that you do not require 

the visual presence of parts in the higher level assembly or other sub-assemblies within the higher level 

assembly. If you do require the mentioned visual presence then you will need addition computer resources to 

accommodate that data in memory.  

If you do need to work in-place activated into a sub-assembly you may benefit from the use of the Hide 

Previous Level command on the View menu. The Hide Previous Level command will hide parts that are above 

your current level in the assembly structure.  

 

Select Tools  

Solid Edge contains a number of select tools whose purpose is to build a select set more efficiently than 

individually selecting a set of parts.  

Find Part  

The Find Part select tool builds a select set of parts by querying properties of the part files. The Category and 

Keyword properties within a part file should be taken advantage of for use with the Find Part select tool. Find 

Part can be used successively to refine the select set by using the Search among parts currently selected option 

on the Find Part dialog.  

 For a part that is considered a standard hardware item you should add the string "hardware" to the 

Category field in the properties of the part. To hide all the hardware in the assembly use Find Part to 

query for "hardware" and then use the Hide command. 

Selection Box  

The Selection Box select tool builds a select set of parts that are within proximity of a seed part. You first select 

a seed part and then graphically draw the 3D box to define the proximity of interest. Parts that are within or that 

intersect the proximity are added to the select set.  

 The select set that Selection Box builds may not be exactly what you wanted to select. Once the select 

set is built you can add to or remove from the select set with normal select behavior using the Shift key. 

Select Small Parts  

The Select Small Parts select tool builds a select set of parts whose range is smaller than a rectangular area that 

you define. Any part whose range is smaller than the area you define is added to the select set. Any part larger 

than the area is not added to the select set. Like the term "large assembly" the term "small part" is relative. 
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 When working in a large assembly it may often be the case that the detail of smaller parts in the 

assembly is not necessary to visually and functionally support the operations at hand. To reduce visual 

clutter try using Select Small Parts in combination with the Hide command. 

Select Visible Parts  

The Select Visible Parts select tool builds a select set of parts by determining what parts in the current view are 

visible to you. If any portion of a part is visible it is added to the select set. Any part that is completely hidden 

by other parts in the view is not added to the select set.  

Graphic Locate  

If you need a part shown for visualization purposes but it gets in the way during select operations you can turn 

off the ability to locate it graphically. The part can still be located in PathFinder but it cannot be located 

graphically.  

 The Selectable option is available on the Properties dialog for a part in an assembly.  
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